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Hello October is finally here. The two weeks in the Seychelles never materialised  

so its only the Christmas hols to look forward to now. 

We are trying a slightly different format to the newsletter this month  to make it  

more easy to read online, for people with shallow monitors or poor eyesight. 

Whilst you can zoom in with the controls at the top of the page, you then may not 

get a full page. Then to read one column and then have to scroll back up the page 

to read the next column is annoying, according to some of our customers. So this 

month we have removed all columns. This makes it slightly less easy to read if 

printed, but less scrolling if reading online. 

We would be interested to hear the views of our readers on this subject , as we 

would on any subject, just email sales@computerdoctors.co.uk.  

As the temperature slowly creeps downwards we should see less PC‘s in the work-

shop for overheating. This doesn‘t mean that you can let it fill up with fluff until it 

resembles a Dyson just ‗cos the weather‘s changed. Take the side panels off, and 

take it outside for a good dibble with a paint brush.  (I‘d wait half hour if it‘s pour-

ing with rain). Your PC will love you for it. 

Unfortunately, you can‘t do the same for a laptop. But a can of compressed air, 

surprisingly expensive at around £7.50, is all you need to blow great wads of fluff 

out of the air vents on the sides or base. Definitely worth the investment if your 

laptop runs hot.  

Plus, just because it‘s called a laptop it doesn‘t mean you can use it on your lap! 

Not only will you block the vents on the underside but you will wear 

out your Windows licence key number on the Microsoft label. This 

means that you can add £90 to your next reinstall bill for a new 

licence key. If yours is starting to fade, stick a piece of plastic tape 

over the product key. (25 digits in 5 groups of 5). Or better still, 

write it down somewhere as once its obliterated, not even Microsoft 

can tell you what it is. 

Craig 

  

http://twitter.com/CraigtheTrainee
mailto:sales@computerdoctors.co.uk?subject=Newsletter%20columns


Ask the Doctor 

Losing Windows' file names can be almost as bad as losing the files themselves. 

 

Getting all your data back the way it was may be possible, but it'll take some serious digging. 

A customer‘s PC suffered a severe drive breakdown: 

"I recently had two hard-drive failures, both slave and master. I recovered my files by running some data recovery soft-

ware but all my photos now have new names like file00000123. Photoshop won't open them — doesn't recognize the 

format‖. 

"The metadata in Bridge shows the real file name under original and/or preserved file name. How do I get my old file 

names back or at least have them recognized by Photoshop and Lightroom?" 

 

You may be able to recover the names, but I'm sorry to say it probably won't be easy. If the names had been easily re-

coverable, the file-recovery process most likely would have found and used them. 

 

I also wonder about the integrity of the "recovered" files. If the files were indeed fully recovered, a tool such as Photo-

shop should be able to open them, even with a changed name. I suspect more got mangled in the crash than may be 

immediately apparent. 

 

Hopefully, with a little more detective work you'll find the path to a solution: 

 

First, try explicitly renaming one of your mangled files. For example, rename file00000123 to test1.jpg. Then try opening 

the file with your normal photo-editing tools. 

 

If that doesn‘t work. Try a general-purpose image viewing/conversion tool. Because these tools are meant to handle al-

most any kind of image file, they may be a lot less fussy about the original file formats than high-end, precision photo-

manipulation tools. 

 

For example, a tool such as the free-to-try, £41.65 to-buy ―Image Converter Plus‖  

http://imageconverterplus.co.uk claims to support over 800 image file types and variants. If your saved files are in a 

format approximating any one of those 800 types, this tool should be able to open them. 

 

Other sites offer free tools — for example, ―Online Image Converter‖ www.online-utility.org/image_converter.jsp 

―ImageMagick‖  www.imagemagick.org/script/index.php 

and the venerable ―IrfanView‖  www.irfanview.com all recognize a wide range of image types. 

 

If you can find any software that can open your test file, you'll probably be able to open all the damaged files and save 

them with new names in whatever format you want. The newly saved files should now open in other, more-exacting soft-

ware. 

 

As for recovering the lost names, a tool like ―Quick File Rename‖ www.skyjuicesoftware.com/software/

QuickFileRename might do the trick. The app is free to try or €37.84 to buy.  

 

As a last resort, you could use a low-level, hard-drive-analysis tool called a hex(adecimal) editor or sector editor to ex-

amine the files (literally byte by byte) to see what information might be in there. You also can use hex editors to rename 

or repair un-openable files. 

 

But I have to warn you: using a hex editor is a very slow, difficult, and laborious process. So it may best be left to data-

recovery professionals. 

 

If you still want to give it a shot after that warning, the Freeware Hex Editor ―XVI32‖ www.chmaas.handshake.de/

delphi/freeware/xvi32/xvi32.htm is excellent and works fine on Windows 7. 

 

But with luck, a non-fussy image-manipulation tool will get your files opened and resaved with usable names and for-

mats. 

 

And if I may climb on a soapbox for a moment: this is one of the reasons it's important not only to have backups but to 

store them away from your PC, where they're immune to PC-based problems. An 80Gb mini external hard drive costs just 

£37.50 and takes its power from the USB, so no power supplies to lug around. 
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When you post online, the name of the game is usually to share your ideas and opin-

ions, or even snippets from your personal life. It should be fun. 

Unfortunately, online posting also opens the door for a whole series of potential 

wrongdoings, from slander and online bullying, to identity theft and crimes that target 

young people. 

Still, these days, most of us want to and do, post online. So we've put together our 10 

Rules to make online posting safer. 

1. Never post anything -- words, pictures, videos, links, emails, blogs, comments and 

tweets -- that you're not happy for the whole wide world to view. 

Because that's the potential of the Internet. There is no hiding place. 

No matter how secure or obscure a site is, there is always the risk that it can be 

hacked, and no matter how little interest you think other people would have in what you said or did, someone you thought 

you could trust may forward or link to the contents you intended to be private. 

2. Think before you post. This was the catchphrase for the 2010 Safer Internet Day campaign, aimed mainly at young peo-

ple. But it applies to all of us every day. 

Some other "think first" tips: 

* Don't post things that aren't true or allegations that you can't prove -- you could land in legal hot water. 

* Don't victimize or bully other individuals (anonymously or not). You could cause a personal tragedy and end up in jail. 

* Don't fire off a comment based on an instant gut reaction that you might regret later. 

* Don't copy someone else's comments or ideas and pass them off as your own. 

* Watch your language! 

3. Be careful how you use your name. Avoid using your full name. Even a nickname could spell trouble -- for instance, if it 

says something suggestive about your character, if it's a name you already use with others who know your real identity, or 

if it's made up from your real name (say, from your initials). First names are best, unless yours is extremely unusual. 

These days, many people do use their full names for online posting -- on social media sites and blogs for example. Just 

know that in doing so you're raising the risk of becoming an identity theft victim. 

4. Don't post photos you wouldn't want everyone to see. Full face, high resolution photos may be "snagged" (copied) and 

used for identity theft. 

Some people don't know how easy this is to do with any photo, with just a couple of clicks. Also, as a matter of etiquette, 

don't post photos of others without their permission, unless you're prepared for the consequences if the other person does-

n't think it's funny. 

For preference, use photos in which identities are obscured. 

And, as a general rule, don't post photos of children online (especially not other people's children without permission). 

If you want to share photos of your kids, put them in a private online album, accessible by invitation or password. Or email 

them directly to your friends. 

5. Keep your postal address and your main email address private. That doesn't guarantee it won't fall into the wrong hands 

-- postal addresses, for instance, are a matter of public record. Set up and use a "disposable" email address for posting -- 

either one you can delete if it gets into the hands of spammers or a different one for each time you have to give it. (By the 

way, you can easily give away your address accidentally by posting a photo of yourself outside your home). 

6. Why would you ever want to give out your phone number to the rest of the world? OK, crooks might be able to find it in 

a phone book, but to prevent identify theft or even abusive calls, don't post online. 

7. We all have a point of view on pretty much everything we read on the Internet. If you want to post online with a com-

ment, many sites ask for your name and email address which, they say, is not for disclosure. Why take the risk? Use your 

first name or even a made-up name, and a temporary email address. 

8. As with the child-photo guidance given above, consider having a closed group on social networking sites that can only 

be accessed by invited users. 

3 

10 Rules to make online posting safer. 



4 

9. Most sites where you can post online comments have a set of rules about how they can use your comments and any 

personal details you provide about yourself. 

These rules are usually viewable via a clickable link to "Privacy Policy." Make a point of reading this before posting. 

And if there isn't a privacy policy, beware! 

10. Don't give information about your planned movements which would let a burglar know when you're not at home. 

And don't give other information that would not only help identify you but also provides useful material to ID theft 

crooks -- like your car registration (or even a photo of you with your identifiable car), N.I. number, your age, and even 

your marital status. 

All of this info can be used to build a "picture" of you for identity theft. 

Some of these may seem obvious and some a bit over the top, but if you speak to someone that has been the victim of 

identity theft, you will realise what a devastating experience it is. 

 

 

 

Ask the Doctor 

"Does defragging the new solid-state hard drives have any benefit?" 

Probably not. The main benefit of defragging is the reduction of the time required to mechani-

cally reposition the drive heads as they seek different pieces of a given file. 

 

SSDs have no moving mechanical components, so there's no real benefit to re-ordering the 

files. 

 

Moreover, making unnecessary writes to an SSD can actually shorten the life of the most-used 

memory cells. For more info, see February 2010 Doctors Orders: 

www.computerdoctors.co.uk/newsletter/NL1002.pdf " Solid-State Hard Disks". 
So, if you're one of the small (but growing) number of people with an SSD, I'd suggest not 

defragging. 

 

 

 

 

We have finally received stock of the Viper i5 desktop PC.  We have run benchmark and diagnostic tests, as we always 

do with a new model, and we all agree that it was worth waiting for.  

The micro case (36cm high) is the same piano (shiny) black as the Viper i3 and although we expected the case to have 

flashing blue lights and spinning multi-coloured fans as lots of the other manufacturers find obligatory these days, we 

were pleased to find the Viper i5 was just as classy looking as its stable mate . The i5 has all the usual extras, card 

reader, dual layer DVD writer, huge 1TB hard drive, as well as the 3.2MHz i5-650 proces-

sor.  

The one we tested also had the optional ATI HD5670 graphics card, pushing the price up 

to £675 but the gaming graphics were superbly fluid and responsive. If you don‘t need to 

play fast action games, the Intel graphics chip built into the motherboard is still a cut 

above the rest and will be perfectly suitable for most users and knocking £100 off the 

price makes the standard i5 an absolute bargain. 

These latest Intel processors require completely different motherboard designs and even 

different (and much faster) RAM memory modules to match the processor speeds. Viper, 

as usual allow us to stock all spare parts to handle any warranty problems in-house to 

speed up downtime. (This is a far cry from most manufacturers). 

For more details see: www.computerdoctors.co.uk/shop/desktop.htm 

Just to celebrate our new PC tower, we are giving away free home installation 

on the i5 and the i3, worth £40 while stocks last. 

Should you defrag a solid-state drive (SSD)?  

Viper Release i5 Desktop PC. 
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A new Amazon scam lurks in a wave of phishing emails launched by Russian identity thieves. 

Several variations of the spoof email have been identified but they all have the same intention of trying to trick victims 

into giving away their Amazon ID and password. 

Armed with these, the scammers order items from Amazon on the victim's account, since many users also store their 

credit card details online with the retailer, so they don't need to be re-entered. 

They may also try to change victims' registered email addresses so Amazon's confirmation of the purchase goes to the 

crooks rather than the account holders, though Amazon will normally notify you of any attempt to change your address. 

Ironically, the most common version of this Amazon con is, in fact, a bogus confirmation of a change in your registered 

email address. 

Bearing the Amazon logo, it is sent to your existing address and is headed "Verify Your New Email Address." However, it 

doesn't say what this new address is supposed to be. 

Instead, you're invited to click a "Confirm" button or a link that appears to be genuine but, in both cases, they take you 

to a bogus Amazon site in Russia that asks you to key in your password. 

In other variations of this Amazon scam, the spoof email seems to be either a shipping notification or a cancellation con-

firmation for an item you didn't order. 

Again, the crooks hope that, on realizing you haven't placed such an order, you'll click on a link that takes you to the 

same bogus Amazon page in Russia. 

Just to make things worse, once they have a victim's sign-on information, they'll try it out on other sites, since many 

people use the same details and passwords for several retailers. 

To avoid this type of phishing email, the most important thing is never to click on links inside such messages. Don't even 

attempt to copy and paste the links into your browser address bar. 

Instead, open your browser (e.g., Internet Explorer, Firefox, Google Chrome or Safari) and type in the online store's ad-

dress (e.g., www.amazon.com), sign on there and go to "Your Account" or "My Account" or something similar. 

There you can check any details about email addresses and orders. You can forward scam emails to  

stop-spoofing@amazon.com. 

Amazon also has a helpful guide on email identification. 

http://www.amazon.com/gp/help/customer/display.html/ref=hp_navbox_phish_ident?nodeId=15835501 

As a further precaution, you can also delete any of your credit card details the retailer holds. And, of course, make sure 

you use a different password for each online account you use. 

 

Hotels Are Card Hackers Top Targets 

Finally, on the theme of hacking and making a regular check of your online accounts, comes the disclosure that almost 

40% of stolen credit card data comes from hotels. 

They make a good target because they often use external companies to manage their computer systems, including credit 

card processing. 

Careless operators at these external firms sometimes leave the digital door open to the hotel systems, enabling hackers 

to come in and steal customers' credit card information. 

Prevention is down to the hotels themselves but, from a customer/guest point of view, the crime underlines again the 

vital importance of regularly monitoring your account. 

According to a recent report, banks and credit card companies are now thinking of asking customers to check their online 

accounts every day. 

Maybe you want to get a jump on them and start right now! It makes sense, too, to regularly monitor your accounts with 

online retailers. 

Even though you're now wise to the Amazon scam, if someone gets your card details from a hotel hack, guess where 

they might go to use it? 

We use a third party company called Trustwave to check the security of our credit card systems in our shop and our web-

site. Just click the Trustwave green logo on our home page for more info. 

Crooks are phishing for your Amazon account 

http://www.amazon.com
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iTunes is one of those programs many of us love to hate. When it‘s working well it‘s okay, but when things go wrong it can 

get spectacularly bad. And quickly. Ever run into an iTunes issue that left you hunting all over the internet and Apple forums 

for a fix? I doubt there‘s any iTunes users who haven‘t spent time doing exactly this. 

So, today we‘re going to look at some of the best iTunes troubleshooting tips and tricks to fix the most amount of problems 

quickly. Let‘s go through the quickest ways to get your iTunes setup behaving normally again. 

 

Whether you‘re using XP, Vista, Windows 7 or a Mac, these same tips will help you to troubleshoot iTunes (OK, Mac users do 

get let off a little sooner than PC users). Items might be in slightly different places, or be called slightly different things, but 

the gist is essentially the same. 

Here‘s the best iTunes troubleshooting ideas in the most effective, least painful order. See the Apple iTunes support pages 

for more specific instructions for your particular device. www.apple.com/support/itunes 

Back Up First! 

Before you start messing around with iTunes, do a quick backup of your entire library folder (especially the .xml and .itl 

files). In newer versions of iTunes (9.2), there‘s a backup option you can use by going to File > Library > ―Back up to Disc‖. 

That will also backup any music you‘ve downloaded from the iTunes store. 

1. Is It Your iPod Or iPhone? 

Sadly, a lot of iTunes problems occur when you‘re trying to use iTunes with an iPod or iPhone. Some of the best trouble-

shooting methods for these troubles involve resetting or rebooting your iPod/iPhone device or updating the firmware for the 

device – all of which is different for each device, so see the Apple support pages. If you‘re lucky, it can be fixed by upgrad-

ing iTunes. 

2. Is It The iTunes Or QuickTime Install? 

It‘s possible your installations are faulty or need updating: 

Re-install iTunes and QuickTime. www.apple.com/itunes/download 

This will both fix any faults and ensure you have the latest version. 

Possibly delete QuickTime (QuickTime sometimes affects video and audio playback). 

3. Is It Your Anti-Virus Software Or Internet? 

Try these steps (check iTunes again after each step to see if it now works): 

Disconnect computer from internet. 

Check for viruses. Remove if required. 

Update/remove virus protection software and virus definitions. 

Disable internet filtering software. 

4. Is It Your iTunes Library Or Account? 

Things to try: 

Create a new library (by holding down Shift when opening iTunes or by moving the old  

library before you open iTunes). 

If the new library works, you might need to import your old library or re-create the old one. 

Slowly re-add files to see if it‘s a problem with an individual file. Create a new user account 

and run iTunes there (see if it‘s broken just for your account). 

 

5. Video/Audio Troubles Only? Enable The Highest Setting 

Throughout iTunes troubleshooting documentation for video and audio troubles has one 

recurring theme: enable the highest setting. 

Go into your sound or video settings and set things to maximum hardware acceleration, maximum screen resolution, enable 

3D video etc. Rule of thumb, ―turn it up‖. 

 

iTunes troubleshooting Tips 
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6. Check Your Plug-Ins 

Remove all your third-party iTunes plugins. 

On Windows XP and Windows 2000, iTunes plug-ins are stored in the following location:  

C:\Documents and Settings\username\Application Data\Apple Computer\iTunes\iTunes Plug-

ins  

Note: The "Application Data" folder is hidden by default. Choose Tools > Folder Options in the file browser window, then click 

the View tab and change the "Hidden files and folders" option to "Show hidden files and folders."  

On Windows Vista or Windows 7, iTunes plug-ins are stored in the following location:  

C:\Users\username\AppData\Roaming\Apple Computer\iTunes\iTunes Plug-ins  

Note: The "AppData" folder is hidden by default. Choose Organize > Folder and Search Options in the file browser window, 

then click the View tab and change the "Hidden files and folders" option to "Show hidden files and folders."  

7. It Might Be DirectX 

If you‘re using Windows [especially XP, 2000 (http://support.apple.com/kb/TS1386) Vista or Windows 7(http://

support.apple.com/kb/TS1718)] and you have video issues, try updating DirectX or disable DirectX in QuickTime (change it to 

Safe Mode GDI instead). 

8. Check Your iTunes Configuration 

Close iTunes. Move the file you‘re testing to a safe place. Restart iTunes. Replace the file if that didn‘t help. 

Temporarily remove the iTunes preferences files (try each file individually by moving it elsewhere and starting iTunes). 

Remove the iTunes configuration files (delete the ―SC Info.sidb‖ file). 

The preference files for Windows Vista and 7 live (http://support.apple.com/kb/TS1717) are here: 

C:\Users\username\App\Data\Local\Apple Computer\iTunes 

C:\Users\username\App\Data\Roaming\Apple Computer\iTunes 

In Windows XP and 2000 the iTunes preference files (http://support.apple.com/kb/TS1421)are here: 

C:\Documents and Settings\username\Application Data\Apple Computer\iTunes 

C:\Documents and Settings\username\Local Settings\Application Data\Apple Computer\iTunes 

In Windows XP and 2000 the iTunes configuration files (http://support.apple.com/kb/TS1776)are here: 

C:\Documents and Settings\All Users\Application Data\Apple Computer\iTunes\SC Info 

Delete the ―SC Info.sidb‖ file and restart iTunes. 

9. Check Conflicting Processes 

Go through the list of current processes, disabling things sequentially to see if you can pinpoint the problem. 

Here‘s Apple‘s guide for using MSCONFIG to check for processes conflicting with iTunes in Windows Vista and Windows 7. (http://

support.apple.com/kb/HT2292) 

10. Update PC drivers 

Look at sound cards and video cards in particular and see if there‘s an available update. 

 

There‘s a number of things that may go wrong with iTunes, and the exact details of the steps you need to take will always be de-

vice-specific, but these are the general troubleshooting ideas which will get you results fast. I hope these were some help. 

If none of the iTunes troubleshooting tips listed here worked and want a change from iTunes now, you could try Songbird 

(http://getsongbird.com/) as an alternative. 
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Microsoft's new version of Windows Live Hotmail brings several new features to the online-mail table.  

 

Some readers have emailed us with tales of woe, cursing the new version and the Windows Live horse it rode in on and 

begging to get their old Hotmail back. Sorry, you can't. 

 

All is not doom and gloom though. As you'll see, the new Wave 4 Hotmail does have its redeeming social values. And if 

you're still suffering through the changes, there are a few tricks that might make dealing with the newer, shinier version 

easier. 

 

Hotmail has had a long and bumpy history. Fifteen years ago, Sabeer Bhatia and Jack Smith left Apple Computers and 

started a free e-mail service known as HoTMaiL. A year later, with more than a million customers in tow, Microsoft 

bought the company and renamed the product MSN Hotmail. Hotmail went through a dozen significant changes in the 

course of several years, with each incarnation promoted as making it "just like Outlook." Of course, Hotmail isn't any-

thing like Outlook — not then, not now. 

 

Microsoft is fighting for online presence and a slick Hotmail helps. The numbers vary wildly, but a couple of months ago, 

one source put Hotmail's share at around 20%. Yahoo's Mail was over 50% Gmail came in at around 12%, and AOL Mail 

was at about 8%.  

The statistics don't really matter. What's important is that a huge number of Hotmail subscribers are facing potential 

problems as they are moved to Wave 4. 

 

New features make attachments easier than ever  

Wave 4 adds several useful new features to Hotmail. Many of them — such as the new built-in media viewers — don't 

require any retraining on the part of Hotmail users. You can, for example, watch linked YouTube videos inside an e-mail 

message. Integrated Office Web apps support lets you work with Office documents within Hotmail — albeit in a limited 

Web-apps way. 

 

SkyDrive integration works with little effort if you click on the correct button. With SkyDrive, Hotmail lets you attach and 

send as many as 200 photos (each up to 50 MB) in a single message.  

Here‘s how. 

Create a new message, click Photos, and then click Create album on SkyDrive. Next, select the images you want to up-

load. Hotmail automatically uploads the files to SkyDrive (this can take some time, depending on the number and size of 

the photos) and creates thumbnails in your message. Status bars next to each thumbnail give its upload progress. 

(Note: you'll have to install Microsoft's Silverlight to upload the files to SkyDrive.) 

The e-mail recipient has the options of admiring your thumbnails, clicking through to SkyDrive to view the originals as a 

slide show, or downloading the original files as a zip. 

 

This new method has a couple of important advantages. It makes the size of e-mails containing photographs much 

smaller, and that saves time when the recipient opens the message. It also solves a Hotmail storage problem: in the old 

Hotmail, those monster image files lived forever in your Sent folder, soaking up storage space — unless you remem-

bered to delete them. With Wave 4 Hotmail, image albums automatically disappear from SkyDrive after a month. 

 

A warning: If you've ever e-mailed a bunch of pictures to yourself, expecting you could retrieve them some months 

later, you're now out of luck. You can increase the expiration date on the album by clicking the link Edit album details, 

which appears in the upper-right corner of the Hotmail new message screen. SkyDrive lets you increase the expiration 

time to 90 days, or you can choose to store them permanently. There's no way to change the default setting for all of 

your future albums — if you want your pictures to stick around for more than 30 days, you need to manually change the 

expiration date. 

Take control of your inbox — carefully  

If you've ever fussed with Outlook's rules, you'll immediately understand the appeal of Hotmail's new Sweep function. 

You can automatically move all messages sent from a specific e-mail address into a special folder — one you created or 

the Junk folder. Here's how: 

Step 1. Start in your Inbox. If you want to move all the messages into a folder that you set up, hover your mouse over 

the Folders link on the left, click on the small wheel icon, choose Add a new folder, and give your new folder a name. 

Step 2. Back in your Inbox, click on a message that comes from the e-mail address you wish to banish — er, sweep. 

Step 3. In the toolbar at the top of the Hotmail screen, click Sweep and then Move all from. Choose the folder you want 

to move the messages to and click Move all. If you want to set up a permanent Sweep rule, check the box marked Also 

move future messages. 

Coping with Windows Live Hotmail - Wave 4  
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If you're a more trusting soul than I am, you can use Hotmail to manage your Gmail, Yahoo Mail Plus, or other POP3-

based e-mail accounts — up to a maximum of four accounts. (Yahoo Mail Plus is a paid account service.) When you send a 

new message, you can choose which account appears in the From account box. 

 

Hotmail now has a Conversation view — it groups messages by subject-line text instead of by chronological order. To flip 

into Conversation view, click on Inbox, Arrange by (upper-right corner of the Inbox), then Conversation. 

 

Coping with the inevitable Hotmail problems  

It would seem that Microsoft believes it has eliminated the major reported Hotmail Wave 4 problems. In a Hotmail forum, 

a moderator-locked Aug. 10 thread (http://www.windowslivehelp.com/thread.aspx?threadid=2ca7275b-a81e-

4753-83fe-4cc030640229) lists a few Hotmail issues and some workarounds. 

 

If you look at the forum's home page, (http://www.windowslivehelp.com/forums.aspx?productid=1) a few hun-

dred posters are still sounding out — some vehemently — about problems with Wave 4. Microsoft's responses tend to fol-

low a prescribed pattern. (I won't say they have a bunch of canned responses, but many of them look, uh, amazingly simi-

lar.) If you're experiencing a problem with the new Hotmail, check out the forum for any useful Microsoft advice and post 

a question if none of the answers fits your difficulties. 

 

One final tip: After upgrading to Wave 4, some Hotmail users discover they can no longer get into their accounts (can't log 

on, can't read mail, or can't send mail) by going to hotmail.com. A few can get into Hotmail by using Windows Live Mail, 

(the heir to Outlook Express in Windows XP and Windows Mail in Vista). If you're at your wits' end and can't get Hotmail to 

budge, follow the steps posted by Technogran on her blog. (http://technograns.wordpress.com/2010/08/01/

problems-with-your-hotmail-upgrade-3/) It's easy, and some people say it even works! 

 

 

 

An exasperated customer decides to ―Ask the Doctor‖ 

 

"I have had it. I had a dual-boot system with Windows and Linux — first Ubuntu and later Linux Mint 7, 8, and then 9. 

Currently I have just Vista and LM9. Several times, Vista deleted the boot entry to Linux. Then on Saturday, it forced a 

chkdsk and somehow deleted the LM9 and the Vista boot managers. Now, I cannot boot into either. Only Vista shows up, 

and it goes in circles trying to boot. Even using the Vista Recovery CD, it says either that it fixed itself or that it cannot 

find an issue. 

"Running (not installing) Ubuntu Live from CD, I can access all of my data. I have copied my documents, my most recent 

Firefox bookmarks, etc., and program files to a working 500 GB extension drive. 

"Can you help me fix the Vista boot loader? I tried manually rebuilding the boot manager, but to no avail. I have tried sev-

eral recovery CDs, and they do not show a Windows installation, even though I know that it is there." 

Sounds like you already tried the Vista and Windows 7 Startup Repair tool.  

But as you probably found out, it's pretty basic.  

Your problem isn't missing system files, it's mangled boot data. That's a less common problem, and the tool that Windows 

provides for that repair is buried a bit deeper. 

The tool is called Bootrec.exe, and it's part of the Windows Recovery Environment in Vista and Win7. It can fix just about 

any boot problem. Bootrec.exe has four options, or switches: 

/ScanOS locates a valid Windows installation on your drive 

/FixBoot fixes (rewrites) the Boot Sector 

/FixMBR writes a fresh Master Boot Record 

/RebuildBcd creates a new Boot Configuration Data store 

You can find complete how-to information for Vista and Win7's Bootrec in MS Support article 927392.  

(http://support.microsoft.com/kb/927392/en-us) 

(XP has its own version of Bootrec accessible through the XP Recovery Console. See MS Support article 307654 for com-

plete information. http://support.microsoft.com/kb/307654/en-us)  

 

With all the necessary boot data refreshed, you should be able to successfully start Windows. 

Once Windows is running, you can then reinstall Linux. The Apcmag.com article, "How to dual-boot Vista with Linux (Vista 

installed first)," offers a step-by-step guide with screenshots. 

http://apcmag.com/how_to_dualboot_vista_with_linux_vista_installed_first.htm 

Dual boot - is it worth the Hassle? 

http://www.windowslivehelp.com/thread.aspx?threadid=2ca7275b-a81e-4753-83fe-4cc030640229
http://www.windowslivehelp.com/thread.aspx?threadid=2ca7275b-a81e-4753-83fe-4cc030640229
http://www.windowslivehelp.com/forums.aspx?productid=1
http://technograns.wordpress.com/2010/08/01/problems-with-your-hotmail-upgrade-3/
http://technograns.wordpress.com/2010/08/01/problems-with-your-hotmail-upgrade-3/
http://support.microsoft.com/kb/927392/en-us
http://support.microsoft.com/kb/307654/en-us
http://apcmag.com/how_to_dualboot_vista_with_linux_vista_installed_first.htm
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It‘s one thing to be selling the cheapest PC in Northampton but to compete with every 

other retailer in the UK and still come out on top has got to say something about the way 

we do business. 

When times were hard a few years ago, it was the introduction of the ―No Frills‖ PC that 

saw us through.  We are still performing health checks and RAM upgrades on these PC‘s 

years later, so it proves that while they were cheap, they were still a reliable entry-level 

machine that can stand the test of time. 

This time around things have changed a bit.  We‘ve got Windows 7, ultra fast SATA hard 

drives and integrated low power processors. But we still manage to sell for £225, cheaper 

than the original ―No Frills‖. 

What hasn‘t changed is the no quibble 12 months RTB (return to base) warranty that we 

support directly ourselves. So if a part needs replacing under warranty, there‘s no strip-

ping it down and shipping the part to the manufacturer for examination before we can 

replace it, we just swap the part out. 

And don‘t forget, our hard drive warranty includes reinstalling Windows, drivers and sup-

plied software and not just the hard drive. As far as we know, no manufacturer does this except Dell and they fit a pre-

installed drive with no option of saving your valuable data.  

(This is something we do off our own back with all the PC‘s we supply, if the manufacturer won‘t cover it, then we will). 

If you want to test us out on eBay www.ebay.co.uk just copy and paste cheap windows 7 pc into the search to 

find out what the competition has to offer. (Strangely enough, when we did this, PC Warehouse Online are selling used 

Dell Optiplex PC‘s with Windows 7 in the title as well as Windows 7 badges, but actually installed with Windows XP. 

You‘ve just got to read the small print with some eBay sellers). 

http://www.computerdoctors.co.uk/shop/desktop.htm 

 

No Frills Plus 

There's no argument that the ―No Frills‖ PC is an ideal entry level PC. For surfing the 

Internet, writing a few letters, storing photos or music, or a hundred other things that 

people do with their PC‘s. But we had a few people that wanted to do a bit extra. ―We still 

want it cheap mind‖, they said, ―we just want to run a few heavy software packages such 

as accounts or Photoshop‖. An impossible task? 

Well we did our best and came up with the ―No Frills Plus‖. It‘s a similar specification to 

the ―No Frills‖ but with a more expensive Intel dual core processor and motherboard to 

make light of a bit more hard work. 

Its got a slightly more plush case, piano (shiny) black, a bit like the Viper i3 & i5, so no 

one will know your PC cost just £265 all in. 

We‘ve still kept the low price and remember these prices include vat which is going up to 

20% on January 4th, so if you want a bargain buy now before the pre-Christmas may-

hem and the post-Christmas vat increase.  

http://www.computerdoctors.co.uk/shop/desktop.htm 

 

Laptops 

We‘ve seen a real rush on laptops at the moment. There‘s no denying 

they‘re very desirable if you need the mobility and small and neat if 

you don‘t, but we always like to stress on our customers the fragility 

of them all. A fall from a table onto a hard floor or a tiny amount of 

liquid over the keyboard is a written off laptop! 

Home contents policies are starting to exclude laptops because of the 

cost but we can cover these for £5.00 per month if taken at time of 

purchase. 

Amazingly, most people don‘t bother. Perhaps we are a bit biased as 

we see a large number of accident damaged laptops. 

http://www.computerdoctors.co.uk/pages/laptop_ins.htm 

 

―No frills‖ is the Cheapest Windows 7 PC on eBay! 

No Frills PC Tower 

£225.00 

No Frills Plus PC 

Tower £265.00 

Toshiba Satellite Pro £365.00 

http://www.ebay.co.uk
http://www.computerdoctors.co.uk/shop/desktop.htm
http://www.computerdoctors.co.uk/shop/desktop.htm
http://www.computerdoctors.co.uk/pages/laptop_ins.htm
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On-Site Rates 

Standard call out charge and hourly rate      £60, 1st hr free + £30 per ½ hr + parts 

New PC or laptop setup (home users only)    £40 if purchased  from us 

         £80 if purchased elsewhere 

 

Remote repair & Support 

Remote Repair (30 mins)      £19.95 in advance 

Remote Repair Standard Contract      £6.99 per month (£79.95 year) 

Remote Repair Plus (+4 free workshop visits per year)   £9.99 per month (£99.95 year) 

(Remote Repair is only available to domestic home users, or a business user based as a single user) 

 

 

 

Workshop Fixed Fees 

 

Standard PC & Laptop repair      £65 + parts 

 -  Data backup (During a PC Repair)     £30 1st user+ £20 per additional user 

 -  Home setup (On-Site, after repair)     £30 

 -  Security pack standard (During a PC Repair)    £10 (antivirus, anti-spyware & file cleaner) 

  - Security pack advanced (During a PC Repair)    £24.99 (Kaspersky internet security) 

 -  Update Windows to latest security packs (During PC Repair)  £20 

Transfer data from old to new PC (purchased from us)   £30 1st  user+£20 per additional user 

Backup data from working PC      £50 1st  user+ £20 per additional user 

Backup data from non-working PC      from £70 per drive 

 

While you wait service (approx 30 mins)     £20 + Parts 

 

Automated overnight hardware diagnostic     F.O.C. 

Manual System diagnostics (not charged if proceeding with repair)  £25 

 

PC or laptop health check (on Working PC)     £40 (+ any parts required) 

 

Data recovery standard (memory card, pen disk, hard drive)   from £70 per drive 

Data Recovery advanced (e.g. broken hard drive)   from £450.00 (quote before repair - £30 on cancel) 

 

Laptop replacement screen      £66.50 + parts 

Laptop screen backlight repair      £95 inc parts 

Laptop screen inverter repair      £115 inc parts 

Laptop power socket replacement      £85 inc parts 

(A non-refundable deposit of £30.00 is required on all component level laptop repairs) 

 

 

For full details of each repair please see our website:  www.computerdoctors.co.uk/pages/rates.htm 

 

For full details of Remote Repair see our website: www.computerdoctors.co.uk/care  or click support on any page. 

Repair time: 

We make every effort to repair your PC as quickly as possible. However some repairs require lengthy diagnostic proce-

dures and we will not shortcut these and compromise the stability of a repair. Some repairs can be fixed quickly and we 

have a while–you-wait service at our workshop as well as a super-fast remote access repair service for your convenience. 

Average workshop repair time is 1—3 days depending on complexity. 

 

vat @ 17.5% is included in all our prices. 

Our fixed fee prices have never been so keen. Now you don’t have to  

compromise quality to get a low cost repair 

file:///E:/My%20Documents/sales_docs/www.computerdoctors.co.uk/pages/rates.htm
http://www.computerdoctors.co.uk/care


Computer Doctors Ltd 

Unit 12 Blackthorn Ind. Est. 

Blackthorn Road 

Northampton 

NN3 8PT 

Contact us 

 
General information & to book a call out 

Tel: 01604 411 444 (9-6 Mon-Fri, 9-1 sat) 

 

Sales & On-Line Purchases 

Tel: 01604 415 984 (9-6 Mon-Fri, 9-1 sat) 

Fax: 0872 115 5359 

Email: sales@computerdoctors.co.uk 

 

Shop: www.computerdoctors.co.uk/shop 

 

Technical Support 

Free: tech@computerdoctors.co.uk 

 

Remote: www.computerdoctors.co.uk/care 

 

Web: www.computerdoctors.co.uk/pages/

askthedoc.htm 

 

Email test Facility: 

mail.computerdoctors@keme.co.uk 

If this has been passed to you from a friend and 

you would like your own regular copy, just go to: 

 

www.computerdoctors.co.uk/newsletter 

 

Map to our Northampton Workshop 

www.computerdoctors.co.uk/

pages/map.htm 

 

Irish police chasing a Polish driver who had apparently committed more 

than 50 motoring offences have discovered the embarrassing truth. 

Officers had been puzzled how the mysterious 'Prawo Jazdy' had always 

produced his documents - but with a different address each time. 

 

An internal Garda memo, reported in Irish papers, said officers taking 

details of Polish traffic offenders had been mistakenly using 'Prawo 

Jazdy', printed in the top right corner of the driving licence, as the 

holder's name. 

 

"Prawo Jazdy is actually the Polish for driving licence and not the drivers 

first and last names on the licence," the police memo said. "It is quite 

embarrassing to see the system has created Prawo Jazdy as a person 

with over 50 identities." 

 

Just to prove that it‘s not only the Irish police that do daft things, here‘s 

another story a bit closer to home. 

 

Police have released eight men after the haul of "cocaine" they were 

seized with, after analysis, turned out to be athletes foot powder. 

 

Officers had announced to news organisations that they had busted a major international drugs ring after the men 

were arrested with a kilo of what they said was cocaine. They were held in custody overnight while officers celebrated 

their "spectacular coup". 

 

But there were embarrassed faces all round when the lab report came back and confirmed the "cocaine" was in fact 

athletes foot powder. 

 

The men were immediately released. 

One said: ''We tried to tell the police when they arrested us but they wouldn't listen. They just smiled at each other 

as they put the handcuffs on us and said 'Yeah, yeah lads good one'." 

View from the Backside 

mailto:sales@computerdoctors.co.uk
http://www.computerdoctors.co.uk/shop
mailto:tech@computerdoctors.co.uk
http://www.computerdoctors.co.uk/care
http://www.computerdoctors.co.uk/pages/askthedoc.htm
http://www.computerdoctors.co.uk/pages/askthedoc.htm
mailto:mail.computerdoctors@keme.co.uk
http://www.computerdoctors.co.uk/pages/newsletter.htm
http://www.computerdoctors.co.uk/pages/map.htm
http://www.computerdoctors.co.uk/pages/map.htm
http://www.computerdoctors.uk.net/pages/map.htm

